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University of lllinois NetMath
Introduction

Welcome to the University of Illinois NetMath Distance Education Program. The course you
are enrolled in is a graduate course offered through Engineering Education at University of
llinois.

The entire NetMath team is here to help you learn calculus. We want you to use all of the
resources available to you to make this a pleasant learning environment. Our staff includes
Professor Jerry Uhl, the author of your electronic textbook, a teaching assistant, a
grader/mentor and Debra Woods, the course director.

Most of your contact in this course will be with your mentor. That person will guide you
through the course, answer your questions and grade your homework submissions. Your
teaching assistant will also answer questions, grade literacy sheet questions and projects. At
the end of the course you will have a conversation with Professor Uhl about what you learned
in the course. This conversation will be your oral final exam and is very informal. There are
no written exams in this course.

These courses also have no lectures. The course philosophy is for students to learn in a
“hands-on” learning environment. The text itself interacts with the student. Homework is done
electronically within Mathematica and then submitted via the Internet. There are also hand
homework assignments that can be either mailed or faxed in.

Within this guide, you will find all the necessary information to successfully participate in this
program: your first homework assignment, instructions on how to configure your computer,
information on who to contact for help and what services are available. Also included are
software and hardware requirements as well as your responsibilities as a student.



University of lllinois NetMath

Contact List

NetMath Project Director at University of lllinois:

Debra Woods

250 Altgeld Hall

1409 West Green Street
Urbana, IL 61801

(217) 265 —0439
dwoods@cm.math.uiuc.edu

Lead Mentors:

Andrew Keaschall
keaschal@uiuc.edu
Faisal Mohamed

amohamed@uiuc.edu
Office Phone: (217) 244-5446

Program Director, Academic Outreach:

Brenda Pacey

(217) 244 - 2030
netmathinfo@cm.math.uiuc.edu
Registration Information

(217) 333 -6305
netmathinfo@cm.math.uiuc.edu

Instant Mentor:

(217) 244 — 5446
mentor@cm.math.uiuc.edu

General Technical Questions:

tech@cm.math.uiuc.edu

Program Director, Engineering Education:

Laura Miller
arriola@uiuc.edu
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University of lllinois NetMath
Beginning the Course

You must be officially registered in the course from the University.

You will be assigned a mentor when we have received your enrollment forms. If a mentor
hasn’t contacted you within two weeks of enrolling, please e-mail Debra Woods at
dwoods@cm.math.uiuc.edu.

Once you are enrolled, you will receive an e-mail message with instructions on how to
proceed in the course. There are also further instructions inside your Coursespace
classroom. The email you receive will include your login to the coursespace.

The University of Illinois will also send you a netID and password. This will come via
U.S. mail. NetMath will not issue your login to our system until your netID is issued so
we can make the logins the same. The password we issue will NOT be the same as your
netID password however since we don’t have access to that information.

Have a copy of Mathematica properly installed and configured on your system. You must
purchase a copy of Mathematica and install it on your computer in order for you to begin
the course. You will not be able to use the Calculus&Mathematica lessons without
Mathematica installed on your computer. Instructions on obtaining Mathematica are
included in this documentation as well as the welcome email that you will receive.

Once you receive your login to Coursespace, please visit the following areas for more
information about your course:

* Change Password

* Information

* Links

* Homework Handin System
* On-Line Chat Room

* Conference Message Board

Have a copy of the current Calculus&Mathematica lessons. Which lesson CD is
appropriate for your course will be included in this document as well as the welcome
email.

Configure all course software according to instructions in this guide.

Create a schedule for working on the course and stick to it. This type of active learning on a
computer works best if you allow at least one hour per session, and is optimal if you can allow
at least 90 minutes to 2 hours per session.
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NetMath Checklist

I have Internet access.

I have an e-mail account
My e-mail address is
(you will need your own e-mail account. Sharing e-mail with another
person or using another person’s account will not work with this

course since most of your communication with us will be by e-mail.)

I have a computer that meets the requirements of this course. (See the technical
requirements at http://netmath.uiuc.edu)

I have a copy of Netscape Navigator 4.0 or higher or IE 5.0 or higher on my computer,
and have viewed the NetMath webpages from there.

I have a copy of Mathematica, or will obtain one as soon as my enrollment is
processed.

I have obtained the Calculus&Mathematica lessons courseware for the class in which |
am enrolled.

I have a decompression program on my computer such as WinZip or Stuffit.
I have time to spend on the coursework.
I am self-motivated and a self-starter.

I promise to make contact with my mentor at least once a week.

Checking the above boxes means that you are ready to start working in your course.
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An Introduction to Calculus&Mathematica-
How to Begin your First Lesson

I. All lessons in Calculus&Mathematica are broken up into 3 sections.
For example, if you are on Lesson 4.01 Splines, the lesson has

. a "Basics" section

Introduces you to the basic math principles in this section.
. a "Tutorials" section

Gives sample problems and their correct answers.
. and a "Give it a Try" section

Contains the problems you will hand-in to be graded- write your answers right
into the notebook and turn the whole thing in.

Note: In the Basics and Tutorials sections, some parts of the written material (like the
answers) are "minimized" in small boxes on the far right side of the screen. To open these boxes,
double click on the cell bracket on the right side of the screen. You will know when a cell has been
minimized because you will see a hook on the cell and a rectangle, which looks like:

|

Also, in a Mathematica "notebook", there contains 3 types of "cells". There are "text" cells which
contain stuff like the title of a section, the description of a problem, and your explanation of how you
did a problem. There are also "input" cells. The words in these cells are of a bold typeface and look
like "computer code". These are the cells that Mathematica will read, evaluate, and then output an
answer (if the code "says" to output an answer) to the third type of cell. These "output" cells contain
answers to "input" cells.

To evaluate the "input" cells, move your mouse anywhere inside an "input" cell and click once
to get your cursor into that cell. Now, either hold down the "Shift" key and press "Return", or simply
press the "Enter" key on the far right bottom of the keyboard. Note: the "Return" key and the
"Enter" key are different keys.

II. When starting a new lesson, the best thing to do is to read all of the Basics section first. The
Basics introduce and explain the new ideas and theories important to each particular lesson. Go
through the section, run the code, play around with it, and substitute in different numbers or functions
and see what happens. Even if you do not understand the material (or the point it is trying to make);
at least read it once so that you have a general idea of what this lesson is like.

III. After reading the Basics, open up the Tutorials. Read at least a few of these sample problems
and make sure you follow their logic in doing these problems. Once you feel confident (or bored)
doing some of these sample problems, it is time to write down your assignment and open up the Give
It A Try section- the homework.

IV. Successful students begin the “Give it a Tries” as follows:



1)

2)

3)

4)

When you first open the “Give it a Try” lesson, go to the File menu and choose “SAVE AS”.
Then save the file under something appropriate such as your last name.nb or assignmentl.nb,
etc. (note: Mathematica files all end with the extension .nb).

Create a Text cell and type your name at the top of the assignment. (See tip VII. if you are
unsure about how to do this)

2.”Cut” out all of the problems which are not assigned. To "Cut" a large section out of your
"notebook", highlight the bracket(s) on the far right side of your screen (of the sections you
want to delete) by clicking and dragging your mouse over them. Now, open the Edit menu on
top of the screen and select Cut.

Make sure that you save your “file” for the first time. To Save your file for the first time, here
is what you do:

a. 1.Make sure that the "file" you want to save is "active" by clicking once, anywhere in
its "window".
b. Open up the File menu at the top of the screen, and select Save As.

c. Inthe new window that has popped up, click the "Desktop" button (on the right side of
the window).

d. Click on the "Hard Drive" which will be labeled something like "Hard Drive" (should
be on the upper left side of the window).

Click the "Open" button (bottom right).
Now, just type a name in for your "file". Example: JohnDoe.4.02.nb
Click on the "Save" button to finish.

= @ oo

Note: Your "file" is now on the computer's "hard drive", to see your file, double click
on the icon that represents the computer's "hard drive" which should be on the upper
right side of the screen (you may have to "minimize" some windows if you don't see
this icon).

V. A good approach to solving the homework problems is to read the “Basics” and “Tutorials” first
and then work on the “Give it a Try”. Many problems in the “Give it a Try” require the addition of
some Mathematica code. Some students choose to write their own code, however, this is not required.
The most common approach to a problem is: Copy & Paste & Edit. Here are the basic steps in this

method

1.

Read the problem. Look for key words that would be unique to this type of problem. Most
importantly, figure out what information they give you, and exactly what they want for an
answer.

Open the Basics and/or Tutorials, and find a sample problem that is closely related to your
current problem. Look for key words.

3. Read and understand this sample problem that is related to your current problem.

Copy the text in the "input" cells of this sample problem, and Paste them at the bottom of
your current problem.

To Copy & Paste, here is what you do:



1. Highlight the text you want to Copy by holding down the mouse button and dragging
your mouse until you have highlighted what you want.

2. Open the Edit menu on the top of the screen and select Copy.

3. Position your cursor where you want to insert your copied text.

4. Open the Edit menu again, and this time select Paste.

5. Change the numbers and/or variables and/or functions so that the copied text is correct
for your current problem.

6. From here, you may have to do more, like finding more "code" to Copy from another
problem. But by now, the problem should be almost done.

7. The last step is to give an explanation of what you did. Always give an explanation!
Your explanation is normally the most heavily graded part of a problem. For each
problem, you must provide a detailed explanation as to how you arrived at the answer.
In the next step, we discuss how to do this.

VI. To type something into your Mathematica notebook, just position your cursor in a cell (except
for an "output" cell) and start typing. If you want to create a new cell (recommended) move your
mouse between two existing cells until your mouse pointer looks like

—

Click your mouse once and start typing. The default cell type is an "input" cell. If you want to
change the cell type to a "text" cell (like for an explanation of a your solution), here is what you do.

1. Select your cell by moving your mouse to the right side of the window and click on the inner
bracket that is defining your cell.

2. Open the Format menu on the top of the screen.

3. Select "Style" (at the very top) then "Text" from this menu.

You can also change the color of your text by a similar method.

1. Highlight the text you want to change, like you do to copy something.

2. From the Format menu, select "Text Color" and then the color of your choice

Additionally you can change the background color of the cell by similar means.

1. Select the cell whose background you wish to change, by clicking on the right hand side in its
bracket.

2. From the Format menu, select "Background Color" and then the color of your choice.

Your mentor will appreciate that you highlight your text with appropriate, easily readable colors, to
reduce eye-strain and make your answers visible in the notebook.



VII. To Save your file (make sure you have done tip [V. part 3. at some time before you do these
steps!!)

1. Open up the File menu and select Save.

2. 2.The new window should show the location of your file; click "Save", and your are done.

VIII. To copy your file to a disk, once you have saved it and closed its window:

Note: You can also use Fetch to store your homework, instead of a floppy disk.

1. Find the location of your file. If you have followed the tips above, it should be on the "hard
drive"; open up the "hard drive" by double-clicking on its icon which is the first icon on the
upper-right side of the screen.

2. Insert your disk, if you haven't done so already.

3. Click on your file, and drag it on-top-of your disk icon. (The disk icon will change color when
the file you are dragging is on top of it.)

4. After a window briefly appears that shows the progress of the coping procedure, eject your
disk by clicking and dragging your disk to the "Trash" icon.

IX. To resume working on a file on your floppy disk:
1. Insert your disk.

2. Open your disk's window by double clicking on your new disk icon. (if the window hasn't
opened automatically)

3. Drag the file you want, and drop it on the "hard drive" (the first icon in upper-right of the
screen).

4. Optional step: Eject your disk; do so by dragging your disk icon, and dropping it on the
"Trash" icon.

5. Double-click on the "hard drive" icon.

6. Double-click on your "file" to begin Mathematica.

Note: To be on the safe side, whenever you start using a new computer, make sure

that Mathematica or Mathematica Kernel is NOT running. You can check this on a Macintosh
by clicking and holding on the "apple" on the very top-right of the screen; this will display
every program that is running. You can check this on a Windows machine by looking at the
tool bar at the bottom of the screen. To quit a program, select it from this menu. Open up the
file menu and select quit. Repeat this procedure to quit more programs.
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Getting help with questions

There are a number of ways you can get help with your NetMath class. You can send an e-mail to
your mentor, use the instant mentor e-mail account, enter the chat room during specified chat hours,
or fax a question to us. Outlined below are recommendations for each method of receiving assistance
for your course.

1)

2)

3)

4)

)

6)

E-mailing your mentor: When you e-mail your mentor, there are a few guidelines you
should consider. First of all, remember they are students who usually have busy schedules
and are not able to handle a large number of questions sent at one time. As you get questions
ask them, and maybe utilize different methods of getting help if you are struggling with a
concept. When e-mailing your mentor with a question please try not to ask more than one or
two questions per e-mail as this ensures you will get a prompt response. If you have many
questions you may want to set up a personal chat hour between you and your mentor to go
over more questions in a more interactive manner.

Using the instant mentor e-mail: The instant mentor e-mail is a source you can utilize if you
need to send an attachment to the chat mentor or have a question that needs answering
urgently. The e-mail address of the instant mentor is mentor@cm.math.uiuc.edu, and if you
send an e-mail during chat hours (see next point for hours) then you can expect a rather
prompt response. Keep in mind though that not all of our mentors can handle a question from
all classes so if that mentor is in the chat room at that time then you may have to wait to get
your question answered.

Entering the chat room: Our chat room is staffed from 7p.m.-9 p.m. some weekday
evenings (see chat schedule for days) and Monday through Thursday and 10 a.m. to 4p.m. A
schedule of the mentors and what classes they can handle is available in coursespace under the
information link.

Faxing in your question: If you have been working a problem by hand and have a question
on it, you can fax it to us. You should send it to (217) 333-9576 attn: Debra Woods. You
should also put your mentor’s name on the sheet and any other relevant information that will
help us out in trying to explain the material. You should get a response within the day (if you
send it early) or at least by the end of the next day.

E-mail the course T.A.

E-mail Professor Uhl (juhl@cm.math.uiuc.edu)
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Grading Policies

Grades will be determined by the following:

Literacy Sheets: .. ....... ... ... ... .. ... 10%
Finalexam:........... ... ... .. .. ... 20%
Homework: .......... .. ... ... ... ... 65%
Weekly communication with your mentor: . . . 5%

Students enrolled in Math 315 or Math 361 for a full unit of graduate credit will also have to
complete an extra final project for their class. This project is substantive and will take
between 15-45 hours of time to complete. Information on the project is included in your
course webpage. The grade on this project will account for 100% of the credit for the extra
hour of credit in which you are enrolled.

Grading Scale:

A 93% - 100%
A- 90% - 92%
B+ 88% - 89%
B 83% - 87%
B- 80% - 82%
C+ 78% - 79%
C 73% -77%
C- 70% - 72%
D+ 68% - 69%
D 63% - 67%
D- 60% - 62%
F less than 60%
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Course Syllabus

The course syllabus is only available on-line. From the NetMath CourseSpace, you can find
the syllabus for your course. The syllabus lists the assignments and due dates for each
homework assignment. These dates are carefully planned to allow you to complete the course
in the allotted time. It is highly recommended that you keep up. If you get off schedule, it is
likely that you will fail to complete the course on time.

You can find the NetMath CourseSpace at: http://cm.math.uiuc.edu/coursespace.

Transcript Information

After completion of a course, some students may require an official transcript as proof of their
credit. This can be obtained through the Office of Admissions and Records Transcript
Department, (217) 333 —0210.

For detailed information, go to their web page at:
http://www.oar.uiuc.edu/current/trans.html or email transcripts @records.uiuc.edu.

Please note that you cannot get a copy of your transcript online. Although the WebPage
offers to do so, only University Students can get their transcript online.

Withdrawal Policy

If you wish to withdraw from the program, you may at any time during the course. Students
wishing to withdraw from a course must complete a Change of Status form. Refunds are
processed according to the campus pro-rata refund policy. The pro-rata refund is based upon
the date that the Change of Status form is received and the class length. Contact Academic
Outreach (phone: (217) 333 — 6305, email: netmathinfo@cm.math.uiuc.edu) for full details
on withdrawal from NetMath and to see if you are eligible for a partial refund. The
instructional support fee of $18 per semester hour is non-refundable. If you withdraw, be sure
to inform your mentor and Debra Woods, in addition to Academic Outreach. There is a
withdrawal form at the back of this guide. It may also be found at

https://www-s.continuinged.uiuc.edu/ao/registration/
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Student Responsibilities

The students are Calculus&Mathematica’s reason for being. The entire NetMath team,
professors, and mentors are here to serve you. Your only job is to put forth a serious effort
and get all you can from the course.

As a NetMath student you must:

Keep in CONSTANT contact with your mentor via email or phone.

Again, if communication breaks down so will the course. Remember that you are
required to make contact at least once a week as a small portion of your final grade.
High school students must report to their site coordinators and mentors. Adult learners
must report to their mentors weekly and a Lead Mentor at least every other week.

Finish all assignments.

Turn in all homework, quizzes and tests on time. The due dates your mentor sets are
not arbitrary, and getting them in on time is important to your progression through the
course. The official due dates can be found on the syllabus in the NetMath
CourseSpace.

Make sure we keep up on our end.

Let us know if we are not holding up our end. Contact the lead mentor or Debra
Woods for problems. Do not be afraid to let them know if you feel that your mentor or
another member of the NetMath team is not performing their assigned duties.

Set a schedule:

All Students must devise a schedule for allotting proper time for their classes each
week. They should also have goals as to when they will turn in assignments and take
quizzes.

Remember:
You bear the primary responsibility for keeping yourself on track. Ultimately, it is up
to you whether you stay on schedule or not.
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Mentor Description

When a student enrolls in a distance learning course through Illinois NetMath, he/she will be
assigned a mentor. The mentor is the student’s communication link with the University.

Following is what a student can expect from his/her mentor:
* Mentors make the initial contact with their new students.

* After initial contact, the mentor will send out an email that explains his/her own personal
procedures that are preferred for things like grading and contact information.

* Mentors maintain at least a weekly contact with their students. Additionally, students are
required to maintain weekly contact with their mentors.

* Mentors grade all homework assignments turned in by their students. Expected turn-
around on grading is one week. Homework will be commented with suggestions as to
how a student can improve their performance on assignments.

* Students may ask their mentor questions pertaining to their assignments at any time.
Questions can come in the form of emails, phone calls, or chat room visits.

* Mentors will pass any questions they can’t personally answer on to the appropriate
University person. As a mentor, you are the first line of defense for your students.

* Students can call the instant mentor (phone mentor) at (217) 244 — 5446 anytime during
scheduled chat hours. Students can use VNC to share a screen with their mentor or visit
the chat room to get help from the phone mentor. When a student calls, they may not be
in touch with their mentor. A schedule of phone hours can be found on the Chat page of
the CourseSpace.

*  Mentors will monitor their students’ progress through the course. When students fall
behind, the mentor will encourage the student to catch up and help them move along.
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Mentor Responsibilities

Mentors of the NetMath team support and direct the progress of the students. The following
responsibilities rest on their shoulders and must be met to ensure the success of those under their
charge.
° Keep in CONSTANT contact with your students
Loss of communication results in a quick degeneration of the program, therefore, this is
very, very important. Not only can lack of communication cause the student to forget
about the mentor, but it is also possible that the mentor may overlook the progress of a
student, allowing them to fall behind.

. Grade and comment on your students’ work
They will be handing in Calculus&Mathematica notebooks and on-line quizzes.
Correcting and COMMENTING upon these assignments is key to your students’ growth.
If you see a trouble area, point it out and do what is necessary to make the student
understand. Recommended turn-around on grading is no more than a couple of days.
The maximum turn-around time is no more than one week.

. Report to the heads of the NetMath team at UIUC and the site coordinator weekly
Doing so will allow them to take the necessary steps (if any) to ensure your students’
success, especially if there are any problems that you feel have left your control.

. Make appointments for on-line help sessions.
These are meetings during which the mentor reviews the work of the students on the
computer while talking to them over the phone. These are prime “question-asking” times
for the students; you must do EVERYTHING in your power to keep these appointments.
The best times for appointments are before and after tests. Make sure the students are
prepared for the test and then afterward, review their mistakes with them.

. Help with basic “trouble-shooting” in respect to the technology.
Answer any on-line and email questions that your students have concerning software or
hardware problems. IF you do not know the answers you are to find someone who does
and contact your students with a solution. It is very important that there is no delay in
relaying a problem to a member of the tech staff. The worst problems are technical
problems because they tend to completely stop the progress of the student.
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The NetMath CourseSpace

This year, all Calculus&Mathematica classes will be using CourseSpace. This on-line
classroom allows the student to do many different things, such as:

¢ Chat with their (or any other) mentor.
* Post messages for classmates to read.
*  Drop off and pick up homework.

* Check out the next lesson.

* Take an on-line literacy sheet quiz.

* Send email to important people.

The URL for the NetMath CourseSpace is:
http://cm.math.uiuc.edu/coursespace

Logging into the NetMath CourseSpace:

At the NetMath CourseSpace page, click on the course you are enrolled in. Enter in the login
and password provided to you by your mentor and click on the OK button. This will take you
into your class’ homepage. On the class' front page, you will find announcements and other
useful information relevant to your class.

The use of the NetMath CourseSpace is very easy. Students have the following tools
available to them upon logging in:

* Announcements
This page shows any changes made in the lesson plan, or anything important the
instructor needs to communicate.

Information
This has pages of information to help students with setting up the necessary materials
for the course. It has information on mentors as well.

Conference
This is a threaded discussion board in which students can post questions or comments
for others to see. If you post a message, everyone else in your class will be able to see
it. It's a great way to communicate with your classmates.



* Homework
The homework page is where students drop off, view and pick up graded assignments.
The homework page also contains a copy of the syllabus for the entire course.

e Chat
This tool will allow the student access a real-time chat room. To view the chat

schedule, please login to the CourseSpace and choose Chat. The phone hours, along
with who is on duty, and what classes they can help with, will be listed here.

* Links

This page contains the links necessary to access Mallard, our on-line quizzing system.
Not all students will have access to this system. Instructions for the Mallard on-line
quiz system are included in this manual. This page also includes links to other web
sites related to the course and help with the course

* Change Password
The main function of the tool page is to allow students to change their passwords.
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Software Requirements

Macintosh:

System Software Mac OS System 8 or newer

IBM (or IBM compatible):

System Software Windows 95, Windows 98, Windows NT, or newer
WinZip or Aladdin Expander

Our servers utilize Compression to reduce file transfer times and save disk
space. Because of this, you will need Winzip, Aladdin Expander, or a
comparable compression/decompression program to open returned homework.

You can download the latest version of WinZip from http://www.winzip.com
and use the evaluation version. Note: This is shareware; students
registering the software will be responsible for any costs that may incur.
You may also download Aladdin Expander from
http://www.aladdinsys.com. This software is freeware and costs nothing.

All Platforms:

Mathematica (versions older than 4.0 are no longer supported)

Mathematica utilizes a user-friendly, graphically robust front end combined
with an advanced computational kernel. Mundane calculations spring to life,
allowing visualizations of Mathematical models and three-dimensional
graphics become a part of the student’s learning method.

Mathematica is available from Wolfram Research, Inc. Special pricing is
available for our students. If you wish to buy a copy from Wolfram itself,
explain your association with our program. You can also buy a copy in most
bookstores (for a reduced price if you have a student ID). To order by phone,
please call (800) 441-MATH or (217) 398-0700 in the U.S. To find out more
about Mathematica, please email Wolfram Research Inc. at
info@wolfram.com or check out its homepage at http://www.wolfram.com.




Web Browser

Once connected to the network, students will need to use a java capable web
browser as their primary interface. This will allow students to download
assignments and turn in homework via the World Wide Web.

Internet Explorer version 4.0 or higher or Netscape Communicator version 4.7

or newer or other equivalent browser is required. Versions earlier than 4.0
will not work properly with our system.

20



Obtaining Mathematica

There are several options for NetMath students to buy the Mathematica software. Follow these steps
to obtain the software.

Full time students can purchase Mathematica either from Wolfram Research or the Illini Union
Bookstore for the student price of around $140. If you are not a full time student, this offer is NOT
available to you.

NetMath students who are enrolled FOR CREDIT can obtain Mathematica from the university.
This version of Mathematica will expire around the 26™ of August each year. Until August, the cost
of this version is $25 without media (45 MB download) or $30 on a CD. Once you have a network ID
number, which is given to you from Academic Outreach when you enroll in the course, follow the
following steps (please note that the netid might be different from your coursespace login):

1) Go to http://www.cso.uiuc.edu/software/sls
2) Click on Login
UNIVERSITY OF ILLINOIS AT URBANA-CHAMPAIGN

UIUC WWW Identification Service

Prezs Legin to identi urzelf via www-s2.mnc.edn.

3) Enter your netid (This is not the same as you login to coursespace)

UNIVERSITY OF ILLINOIS AT URBANA-CHAMPAIGN

UIUC WWW Identification Service

NEtID|| | Enter I
Enter vour Trniversity NetIDy then press Enter.

4) Enter your password

UNIVERSITY OF ILLINOIS AT URBANA-CHAMPAIGN
UTUC WWW Identification Service
P‘asswuld| | Enfer I

Enter password* for HellD dwoods2, then press Enter.

#oame as bor 1T of I Drect or terminal serwers
I

5) At the login successful page, click Return

UNIVERSITY OF ILLINOIS AT URBANA-CHAMPAIGN

UIUC WWW Identification Service

[Retuin

LI:I% 1 successiul. Click Refurn to retumn to elms.e—amdem:.mm.

6) Select Mathematica 4.X for students at the Search by product titles menu.
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Software

[ Search by product titles = ] [Gu]

| Search by product categories | |Go]

[ S5earch by operating systems = ] [Gu]
Mathematica 4.1 for Windows student £25.00 USD
Students A undergrad

AATIEMAEA ; h‘

Mathematca

7) follow the on-line instructions for purchasing the software

8) If you want to have it delivered to your address, you will have to pay shipping:
Price: $25.00 UsSD

v Delivery Option [
Download
Pick Up (+ $5.00)
Mail Order (+ $6.00)

Any NetMath student whether for credit or not for credit can obtain the software directly from
Wolfram Research for $50 for 6 months or $75 for 1 year. To order by phone, please call (800)441-
MATH (6284) in the U.S. To find out more about Mathematica, please e-mail Wolfram Research Inc.
at info@wolfram.com or check out its homepage at http://www.wolfram.com
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University of lllinois NetMath
Hardware Requirements

Macintosh

The minimum requirements for a Macintosh is a Power PC, 200 MB hard disk space, System 8 or
later, 128 MB RAM minimum, (256 MB RAM or more recommended);

A list of recommended machines includes:
Any iMac or iBook

Any G3 or G4 Macintosh

Any Power Macintosh

IBM (or IBM compatible)

Windows 95, Windows NT, Windows 2000, or newer

128 MB RAM minimum (256 MB RAM or more recommended)”
200 MB of hard disk space

Windows 98- 128 MB RAM required, due to corruption problems between notebook files and that
particular version of Windows.

Internet Access

A fast modem connection allows students to gain an Internet connection over standard
telephone lines. 56.6 KBPS and above modem is recommended.

Broadband is preferred over a modem.

" For large data sets, or to maximize performance, installing additional ram is strongly recommended. For Macintosh
systems without a level 2 cache, adding a level 2 cache of at least 512K will greatly increase computer efficiency.
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University of lllinois NetMath
Troubleshooting Problems with Mathematica

Mathematica is an extremely large program and is very sensitive to system setup. Some
people have problems getting it set up properly on their computers in the first place while
others have problems if their file becomes corrupted. Here are some ways to avoid or fix
problems should they arise:

NEVER run Mathematica from a file on a floppy disk, or save a file directly from
Mathematica to a floppy disk.

Save frequently (after every problem).

Make backups of each file before you begin. That is, work on a working copy of the
file.

If you have problems with your installation of Mathematica, go to one of the following
WebPages for help. This will delete your settings and preferences.

= http://support.wolfram.com/mathematica/interface/customize/corruptpreferencescache.html
= http://support.wolfram.com/mathematica/interface/customize/corruptpreferencesfile.html

If you find yourself with a corrupt file, try the following web address to fix the
problem:
= http://support.wolfram.com/mathematica/interface/notebooks/fixingcorrupted.html
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University of lllinois NetMath
Configuring Mathematica for Macintosh

Once Mathematica 4.1 is installed on your computer, you will see a folder labeled

Mathematica 4.1 Files. If you open that folder, you will see another folder labeled
Executables. Open the Executables folder.

O (5} Mathematica 30Rles = 1 B
10 items, 2.3 GB available
Mame =)
b [ 4ddons

b [ Configuration
b [ Documentation
= (0] Executables
o ffi Power Mac
& Mathematica 3.0
L Y athkernel
£y rrtemtice 30
I [ Registration .
b [ SwstemFiles
v |

KID

Inside the Executables folder, you will see Mathematica 4.1 and MathKernel. Click the

mouse once on the Mathematica 4.1 file to highlight the file. Now select Get Info from the
File menu at the top of your screen. (Apple-I will also work). You will see a window that
looks like:

A



1 Mathematica 3.0 Info =

|Mathematica 3.0 |
Mathematica Front End 3.0.1
Shuw:[ Memory =

Kind: application program

Memory Requirements

Suggested Size:  S120

4
Minimum Size: |4096 K
Preferred Size: |7000 K

Mote: Memory requirements will increase by 3,499 K if
virtual memoary is turned off.

[ Locked

You may have to select Memory from the Show menu. Make sure that the Preferred Size is
set to around 7000 K as above. Click Okay to confirm the adjustments.

Now, perform the same procedure to adjust the Preferred Size of the MathKernel to around
15000 K.

Some of the work you will do in your C&M lessons will be quite taxing on Mathematica.
You have just increased the amount of memory that Mathematica and its kernel can address
during a session. This should decrease the incidence of computer crashes provided you have
enough memory in your computer.

Note that if you have virtual memory turned off, the memory requirement will increase by
3500K.

Please note: The screenshots used in this section are for Mathematica 3.0. The only
difference when dealing with Mathematica 4.1 should be the name (IE- It will say
Mathematica 4.1 instead of 3.0).
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University of lllinois NetMath
Configuring Mathematica for PC’s

Once Mathematica 1is installed and registered on a PC, it should be ready to run. At this time,
there are no required configuration steps. The lessons may be accessed directly from the
CD, or installed on the Hard Drive.

In the Extras directory on the courseware CD, you will find three notebooks that can
optionally be installed..

The file MEImathstyle.nb is the style sheet used for the lessons, and may be installed to the
following folder:

C:\Program Files\Mathematica\4.1\FrontEnd\StyleSheets\ (for Mathematica 4.1)
Doing this will allow you to create new notebooks in the same style as the courseware. After
copying this file to the directory, it will become an available item under the StyleSheet

selection of the Format Menu in Mathematica.

The two other important files in the Extras are ColorSelector.nb and RGBColorSelector.nb
You may install these files into the following directory:

C:\Program Files\Mathematica\4.1\FrontEnd\Palettes\ (for Mathematica 4.1)

Doing so will allow you to access these Color Selection Palettes from Palettes submenu of the
File menu in Mathematica.
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University of lllinois NetMath
Lesson Configuration

In the Extras directory on the courseware CD, you will find several notebooks that can be
installed for various reasons. The file MEImathstyle.nb is the stylesheet used for the lessons,
and may be installed to the following folder:

System Folder:Preferences:Mathematica:4.0:FrontEnd:StyleSheets (for Mathematica 4.1)

Using this will allow you to create new notebooks in the same style as the courseware. After
copying this file to the directory, it will become an available item under the StyleSheet
selection of the Format Menu in Mathematica.

The two other important files in the Extras are ColorSelector.nb and RGBColorSelector.nb
You may install these files into the following directory:

System Folder:Preferences:Mathematica:4.0:FrontEnd:Palettes (for Mathematica 4.1)

Doing so will allow you to access these Color Selection Palettes from Palettes submenu of the
File menu.
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University of lllinois NetMath
NetMath Graduate Course Catalog

MATH 351a. Calculus Refresher

A review of the first course in calculus and analytic geometry; basic techniques of differentiation and integration
with applications including curve sketching; antidifferentiation, the Riemann integral, fundamental theorem,
exponential and circular functions. Also includes techniques of iteration, conic sections, polar coordinates, and
infinite series.

Prerequisite: Two semesters of undergraduate calculus. 3 hours (3/4 graduate unit)

MATH 351b. Systems of Linear Differential Equations
This course reviews systems of linear differential equations including vector fields and flow fields, eigenvectors and
eigenvalues and linearizations.

Prerequisite: Undergraduate course in differential equations. 1 hour. (1/4 graduate unit)

MATH 315. Linear Transformations and Matrices

Introductory course emphasizing techniques of linear algebra; topics include matrix operations, determinants,
linear equations, vector spaces, linear transformations, eigenvalues, and eigenvectors.

Prerequisite: Math 242 or 243 or 245. 3 hours, 3/4 or 1 unit. One unit credit requires approval of the
instructor and completion of additional work of substance.

MATH 361. Introduction to Probability Theory, |

Introduction to mathematical probability; includes the calculus of probability, combinatorial analysis, random
variables, expectation, distribution functions, moment-generating functions, and central limit theorem.
Prerequisite: Math 242 or 243 or 245 or equivalent. 3 hours, or 3/4 or 1 unit. One unit credit requires approval
of the instructor and completion of additional work of substance.
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University of lllinois NetMath
Textbook/Lessons Information

Copies of the electronic lessons are required for this course. You can print out a copy for
yourself or have Kinko’s print them for you if you would like a printed reference. The lessons
(formerly available on cd) can be purchased from Math Everywhere, Inc. Please visit
http://www.matheverywhere.com to pay online and download the lessons directly, along
with pdf files that can be used for printing. To find out more about Mathematica, please e-
mail Wolfram Research Inc. at info@wolfram.com or check out the homepage at
http://www.wolfram.com.

There are no bound textbooks for the class, only the electronic lessons.

If you purchased the lesson CD's while they were available, they can still be used. The
respective CD's work for the following classes:

REQUIRED CDs:
Calculus&Mathematica: by Davis, Porta, and Uhl — Used in Math 351a
Differential Equations&Mathematica: by Davis and Uhl — Used in Math 351b

Matrices, Geometry&Mathematica: by Davis and Uhl — Used in Math 315

Math 361 lessons are downloaded from:
ftp://cm.math.uiuc.edu/pub/CM _Lessons/7.0Prob_Stat/
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REQUEST FOR CHANGE OF STATUS OR WITHDRAWAL
Academic Outreach Credit Course

Directions: Students who wish to change their academic status from credit to audit (visitor) or
withdraw from an off-campus or online course must complete this form and return it to the
Academic Outreach office, 302 E. John Street, Suite 1405, Champaign, IL. 61820 or fax (217)
244-8481 as soon as possible. The dates for the last day to withdraw and receive a tuition refund
are listed in the Academic Outreach brochures, or you can get them by calling the Division of
Academic Outreach at 1-800-252-1360. Please print or type the information below.

Student Name: Social Security #

Address:

(Street Address) (City/State/Zip)
Course Rubric and Number (e.g. SOC 328, LIS 423, etc.):

Class Location Semester Year
Instructor
Are you a degree-seeking candidate? yes no

Status Change Requested: (Please check)
Change from credit to audit/visitor
Change from audit/visitor to credit
Withdraw from a class
_ Other

Reason for Change of Status or Withdrawal:

Student’s Signature Date

DO NOT WRITE BELOW THIS LINE

To: University Recorder No refund of tuition
Refund approval $

Head, Division of Academic Outreach Date:

Other approvals required (signatures required if box checked):

Signature required by: Date

Signature required by: Date



